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Microsoft Word 
 

 ذخیره سازی  ، باز کردن  و ایجاد فایل جدید
 

 ایجاد کردن یک فایل جدید:

 روش ها :
1-File > New > Blank document 

 از نوار ابزار  Newانتخاب دکمه -2
3-Ctrl+N 

 دهید. فشاررا باهم   Nو  Controlهای  یعنی کلید
 

 : ذخیره کردن یک فایل
1-File >> Save As 

  Expandرا مشاهده نمی کنید منو را ه : در صورتی که هنگام جستجو در منو ها ، گزینه مورد نظرتان توج -
 )بزرگ( کنید.

 از نوار ابزار  Save انتخاب دکمه -2

3-Ctrl+S 
  doc.خواهند بود و پسوند آن ها   document    اسم پیش فرض فایل ها -

 : باز کردن یک فایل
 

1-File > Open 

 از نوار ابزار   Openب دکمه انتخا-2
3-Ctrl+O 

 

 

 

 تنظیمات صفحه :

Page layout >> Page setup 
Margin حاشیه 
Gutter  شیرازه 
Orientation:   portrait (عمودی), landscape )اففی( 
 
Paper size : ابعاد کاغذ 

 
 خط کش ها:
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view >> ruler      فعال یا غیر فعال کردن خط کش ها  

 

 بل از خط کش ها نشان دهنده حاشیه صفحه است.ق یمرز رنگ
 

 قالب بندی متن:

 با استفاده از نوار ابزار فرمت   -1
 برای افزایش یا کاهش  یک واحد ، یک واحد در سایز فونت :

Ctrl + [ 
Ctrl + ] 

Blod   Ctrl + B 

Italic  Ctrl + I 

Under line   Ctrl + U 

Align: 

Center   وسط چین  Ctrl + E 

Left  چپ چین  Ctrl + L 

Right  راست چین Ctrl + R 

Justify طراز از دو طرف Ctrl + J 

 

 برای اعمال هرگونه تغییرات باید ابتدا متن یا شی مورد نظر را انتخاب کرد wordتوجه : در  -
 

 دقیق متن  قالب بندی

Home > Font    (Ctrl + d). 
Font Tab: 

Latin text    ای لاتین به متن ه مربوطفونت  
Complex script    فونت های مربوط به زبان فارسی 
Font color  رنگ قلم 
Underline style     طزیر خنوع  
Underlin color طزیر خ رنگ  

Effects   
Strike through خط زدن    

Double Strike through   مضاعفخط زدن  
Super script ی گیردمتن انتخاب شده بالاتر از خط زمینه قرار م  

Sub script متن انتخاب شده پایین تر از خط زمینه قرار می گیرد 
Shadow سایه دار شدن متن 
Out line تو خالی کردن فونت 
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Emboss  برجسته کردن فونت 
Engrave تو رفتگی فونت      

Small Caps    حرف اندازه اولینبزرگ کردن  
All caps   کردن حروف بزرگ  
 

 :گرفپاراتنظیمات مربوط به 

Format > Paragraph 

Alignment تراز بندی 
 دو نوع تراز بندی وجود دارد. تراز بندی  چپ  برای متن های لاتین و راست برای متن های فارسی

- Word  جهت متن (direction) .را به صورت اتوماتیک تعیین می کند 
 

Indentation تو رفتگی 
Before text  تو رفتگی از سمت چپ 
After text تو رفتگی از سمت راست 
 

 

Specianl  

  

 

 

 

Spacing 

 

 ایپ !شروع به ت ازقبل چند نکته 
  (right)را راست  alignو  (right to left)را راست به چپ  direction در صورت تایپ فارسی حتما  -

  بگذارید.

اگراف برای رفتن به خط بعد از در یک پاراستفاده کنید. پس  Enterبرای ایجاد یک پاراگراف جدید از کلید  -
برای رفتن به خط بعد از  .آن خط را یک پاراگراف تلقی می کند word  استفاده نکنید زیرا Enterکلید 

Shift+ Enter .استفاده کنید 

 استفاده کنید. Ctrl+ Enterبرای شکست صفحه  )رفتن به صفحه جدید( از  -
 
 

First line تو رفتگی برای خط اول پاراگراف   

Hanging  پاراگراف تورفتگی مربوط به خطوط دیگر  

Before  فاصله از پاراگراف قبلی 

After فاصله از پاراگراف بعدی 

Line Spacing 

Single   حالت پیش فرض 

1.5 lines  1.5 برار  

Double  دو برابر 

At least  حداقل 

Exactly  اندازه دقیق 

Multiple چند حالته 
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 روش های کپی :
 ، سپس :   (highlight)می کنیم  بخاانتابتدا متن مورد  نظر را 

 را انتخاب می کنیم.  Copy:  راست کلیک کرده  و  1روش 
 می کنیم. بانتخارا   copyینه ، گز  Homeاز منو : 2روش 

 Ctrl+ C:  3روش )روش سریع (

 کردن متن کپی شده :  pasteبرای  
 را انتخاب می کنیم.  pasteراست کلیک کرده  و  -1
 می کنیم. بانتخارا  pasteینه گز ،  Homeاز منو  -2

 Ctrl + V )روش سریع ( -3

 می شود. به جای کپی ، جابه جاهمانند کپی است اما متن انتخابی  (Cut)روش های انتقال 
 )کشید( کرد. Dragمی توان مستقیما متن انتخابی را  لبرای عمل انتقا

 

 
Insert picture   

Insert > picture > from file 

 فعال می شود. picture د کردن تصویر از این گزینه استفاده می کنیم. با وارد کردن تصویر نوار ابزاربرای وار
 

Color  

 
 

 

 

 
 ایجاد کادر و پس زمینه برای صفحه 

Page layout > Page Borders  

ات تنظیم  page borderتنطیمات برای یک پاراگراف انجام می شود اما در تب   Bordersتب توجه : در 
 برای تمام صفحات انجام می شود.

 

 

 

 ترسیم جدول 
Insert > Table 

 

 
 ! نکته : قبل از رسم جدول ، جهت متن را تعیین کنید ، در غیر این صورت جدول چپ چین می شود

Automatic معمولی 

Grayscale تصویر خاکستری      

Black & white تصویر سیاه و سفید    

Washout تصویر مات      



6 

 برای حرکت بین خانه های جدول 
 استفاده کنید. shift+Tabاستفاده کنید و برای برگشت به خانه قبل از  TABبرای حرکت به سمت جلو از 

 توجه : می توانید با کلید های جهت دار نیز اینکار را انجام دهید.
 به هریک از خانه های جدول یک سلول می گویند.

 می کنیم. بانتخاسلول ها را  کشیدن موسنظر شده ، با  موردبرای انتخاب یک یا چند سلول ، وارد سلول 
 

 حذف سلول ها 
 را انتخاب می کنیم delete cellsیک کرده و روی سلول مورد نظر راست کل

 
 ادغام کردن سلول ها 

را انتخاب می  cells  mergeابتدا سلول های  مورد  نظر را انتخاب کرده ، سپس راست کلیک کرده ، گزینه
 کنیم.

 تقسیم کردن سلول ها
باز شده ،  split، پنجره  را انتخاب می کنیم spilt cellدر خانه مورد نظر قرار گرفته ، کلیک راست و سپس 

 تعداد سطر ها و ستون ها  را وارد می کنیم تا سلول به آن تعداد تقسیم شود.
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Microsoft Powerpoint 

 

 

 All و منوی فرعی Start . پس از نصب آن باید از منوی PowerPoint برای شروع کار با

Programsمنوی،Microsoft Office را باز کرده و گزینه Microsoft Office PowerPoint 

 را انتخاب کنید. 2010
 کلید کنید. Start بر روی کلید
 کلیک کنید. All Programs روی گزینه
 کلیک کنید. Microsoft Office روی گزینه

 را انتخاب کنید Microsoft Office PowerPoint 2010 از منوی باز شده ، گزینه

 
اجرا شده و شما می توانید محیط آن را مشاهده کنید. قبل از هر چیز بهتر است با  PowerPoint هحالا برنام

 قسمت های مختلف این محیط بیشتر آشنا شوید.
است. در این قسمت نام  PowerPoint قسمتی که با کادر قرمز مشخص شده است،میله ی عنوان برنامه

داده می شود. تا زمانی که شما نامی برای نمایش خود انتخاب  نمایشی که در حال حاضر باز می باشد، نمایش
که بعد از آن یک عدد قرار گرفته است،  presentation را بطور خودکار نام آن PowerPoint نکرده اید،

  انتخاب می کند.
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ست قرار گرفته ا Quick AccessToolbar در سمت چپ میله عنوان یک میله ی ابزار ابزار کوچک به نام

که شامل ابزار هایی که معمولا زیاد مورد استفاده قرار میگیرند می باشد. شما میتوانید با استفاده از کلید حاوی 
 فلش سیاه رنگ کنار این میله ی ابزار ، ابزارهای مورد نظر خود را به این میله ی ابزار اضافه نمایید.
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در سایر برنامه ها عمل می کند، با فشردن این کلید،  ت چپ و بالای صفحه همانند منوی فایلسمدر  File کلید

 می باشد. PowerPoint صفحه ای باز می شود که شامل دستوراتی برای مدیریت فایل های
می باشد که به این  PowerPoint قسمتی که توسط کادر قرمز مشخص شده است،مجموعه ی ابزارهای

رگه است که با انتخاب هر برگه ابزار های مربوط به شامل چندین ب Ribbon گفته می شود. Ribbonمجموعه
فعال می باشد که شامل پر  Home برگه Ribbon آن برگه نمایش داده می شود. به طور پیش فرض در

 استفاده ترین ابزار هایی است که درطراحی نمایش ها از آنها استفاده می شود.
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که عملکرد مرتبط به هم دارند در یک گروه دسته بندی  Ribbon برای سادگی کار، برخی از ابزارهای موجود در
شده اند. در حال حاضر شما می توانید گروه 

 را مشاهده کنید.Clipboard،Slides،Font،Paragraph,Drawing،Editing ابزارهای
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یک کلید کوچک حاوی فلش قرار گرفته  Ribbon در پایین سمت راست بعضی از گروه ابزارهای موجود در
است. با کلیک بر روی این کلیک کوچک پنجره ای برای دسترسی به سایز گزینه های آن گروه های آن گروه 

 ابزار در اختیار شما قرار می گیرد.
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، بصورت کم رنگ نمایش داده می شوند، ابزارهای غیر فعال می باشند که فعلا قابل Ribbon ابزارهایی که در
ها در شرایط خاص و در صورت نیاز فعال می شوند.در شکل تعدادی از ابزار های غیر استفاده نمی باشند. این ابزار

 فعال توسط کادر قرمز مشخص شده اند.
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وجود دارد که  Outline و Slides ،پنجره ای شامل دو برگه بنام هایPowerPoint در سمت چپ محیط
متون موجود در اسلایدهای  Outline ه یپیش نمایشی از اسلاید های موجود و در برگ Slidesدر برگه ی 

 نمایش داده می شوند.
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قسمتی که توسط کادر قرمز مشخص شده است. محیط طراحی اسلایدهای نمایش می باشد. در این قسمت شما 
انتخاب کرده اید مشاهده  Outline یا Slides می توانید در هر لحظه یک اسلاید از نمایش را که در برگه

 ا ویرایش کنید.کرده و آن ر
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در پایین محیط کادری وجود دارد که برای اضافه نمودن توضیحات مربوط به اسلاید مورد استفده قرار میگیرد. 
 شما با این قسمت در فصل های آینده بیشتر آشنا خواهیم شد.
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د تعداد اسلایدهای که در پایین صفحه قرار گرفته است. اطلاعات مختلفی مانن Status Bar نوار وضیعیت یا
نمایش، شماره ی اسلاید فعلی، سبک استفاده شده برای اسلایدها و .... را نمایش می دهد. شما میتوانید با راست 
کلیک بر روی نوار وضعیت و انتخاب گزینه های مناسب از منوی باز شده، اطلاعات نمایش شده در نوار وضعیت 

 را کنترل کنید.
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که در سمت چپ صفحه قرار گرفته اند.  Outline و Slides ی برگه دو جز به ،PowerPoint در برنامه
چهار نمای دیگرنیز برای نمایش اسلایدها وجود دارند که عبارتند 

، ای چهارنما با Slide Show و Normal View ، Slide Sorter View ، ReadingViewاز:
ضعیت که با کادر قرمز مشخص شده اند، قابل دسترس استفاده از کلید های کوچک موجود در سمت راست نوار و

 می باشند.
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در انتهای سمت راست نوار وضعیت ابزارهای مزبوط به بزرگ نمایی قرار گرفته است. در این قسمت به ترتیب از 
قرار گرفته اند که در  Zoom Level،Zoom Slider، Zoom to Fit چپ به راست سه ابزار بنام های

 ن ابزار ها آشنا می شوید.ادامه با ای
 



19 

 
 

پنجره ای بر روی صفحه ظاهر می شود که با استفاده از گزینه های  Zoom Level با کلیک بر روی ابزار
 موجود در آن می توانید میزان بزرگ نمایی را تعیین کنید.

 کلیک کنید. Zoom Level روی ابزار
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برای بزرگ نمایی در اختیار شما قرار می دهد. گزینه های متعددی را  Zoom پنجره بزرگ نمایی با
در این پنجره به شما کمک می کند که بتوانید میزان بزرگ نمایی را به صورت یک عدد بر Percent قسمت

و انتخاب یک  zoom in موجب عمل بزرگنمایی یا 100% حسب درصد تعیین کنید. انتخاب یک عدد بزرگتراز
می شود. در اینجا ما می خواهیم بزرگ  Zoom Out چک نمایی یاموجب عمل کو 100% عدد کوجکتر از

 نمایی اسلاید را به دو برابر افزایش دهیم.
 کلیک کنید. 200% روی گزینه
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مشاهده میکنید که بزرگ نمایی اسلاید دو برابر شده است. حالا بهتر است، بزرگ نمایی اسلاید را به حالت قبل 
می باشد. با کلیک بر روی ای ابزار ، بزرگ نمایی  Zoom to Fit استفاده از ابزار بازگردانیم. ولی راه ساده تر

 اسلاید به گونه ای تغییر میکند که تمام اسلاید در صفحه دیده شود.
 کلیک کنید. Zoom to Fit روی کلید
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می  Zoom Slider به منظور بزرگ نمایی مورد استفاده قرار می گیرد. ابزار PowerPoint ابزار دیگریکه در
باشد که توسط کادر قرمز مشخص شده است. این ابزار شامل یک کلیک لغزان و دو علامت مثبت و منفی در دو 
طرف آن می باشد که لغزاندن آن به سمت علامت منفی موجب کوچک نمایی اسلاید می شود . همچنین برای 

 و منفی نیز کلیک کنید. بزرگنمایی و کوچک نمایی می توانید مستفیما روی علامت مثبت
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 Insert سربرگ امکانات

 :دارد وجود مهمی و زیاد های گروه سربرگ دراین

tables:رود می کار به دلخواه ابعاد در جدول کردن اضافه برای گروه این. 

 Images:داخل های عکس از شود می شود می استفاده نمایش به عکس انواع کردن اضافه برای گروه این 
 .کرد استفاده عکس وآلبوم پوبنت پاور آماده های عکس و رکامپیوت

 این های عکس و گرفت عکس صفحه از  شات اسکرین وسیله به توان می چنین هم
 .است شده تهیه وسیله همین به نیز وبلاگ

Illustrations :آماده های شکل کردن اضافه به مربوط اول بخش. شود می مشاهده بخش سه گروه این در 
 .است
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 های نمودار و نامه شجره دادن نشان برای که است.......  و ها هرم و ها نمودار و ها شکل به مربوط دوم خشب
 .رود می کار به........ و هرمی و ای شاخه

 ها نمودار انواع دیگر و ای دایره و هرمی و شکسته و ای میله آماری های نمودار برای چارت یا سوم قسمت از
 .شود می استفاده

 در رابطه این در که کنیم می اکسل وارد را خود اطلاعات نمودار کردن درست ایبر
 .گیریم می یاد بیشتر وبلاگ دیگر مطالب

Links :پوینت پاور محتویات سایر و ها نوشته و ها شکل به توانیم می بخش این های گروه زیر وسیله به 
 داده ارجاع  دلخواه نمایش یک یا و فایل یک و نتیاینتر آدرس یک به کنیم کلیک آن روی اگر که بدهیم امکانی
 .شویم

Text :امکان طور همین دارد وجود  نوشتاری های جلوه و نمایش به نوشته کردن اضافه امکان گروه این در 
 .شویم می آشنا بیشتر آنها با بعدا که پاصفحه و سرصفحه کردن اضافه

Symbols :ندارد وجود کیبورد در که های علامت و ها نماد یا و کنیم وارد مختلف های فرمول میتوانیم آن در. 

Media:های فایل از تواند می که کنیم اضافه نمایش به صوتی و ویدیویی فایل توانیم می قسمت این در 
 .باشد وب بر موجود های فایل یا کامپیوتر

 سازی و آشنایی با قسمت های دیگر پاورپوینتذخیره 

آشنا شدید، حالا بهتر است یک نمایش که قبلا  PowerPoint تا این مرحله با قسمت های مختلف محیط

نیز آشنا شوید، برای باز کردن یک نمایش  PowerPoint ایجاد شده است را باز کنید تا با سایر قسمت های

 استفاده کنید. File منوی واقع در Openمی توانید از گزینه

 کلیک کنید. File روی کلید

http://powerpointtraining.persianblog.ir/post/7/
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 راانتخاب کنید. Open از منوی باز شده گزینه
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باز می شود که با استفاده از آن می توانید فایل مورد نظر خود را  Open ، پنجره ی Open با انتخاب گزینه ی

دسترسی به شاخه های پر استفاده انتخاب کنید. توجه کنید که سمت چپ این پنجره گزینه های برای 

 و .... وجود دارد. Desktop ،Documents نظیر

 روی فایل مشخص شده دابل کلیک کنید.
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واقع در  Slides همانطور که مشاهده می کنید فایل مورد نظر باز شده و اسلایدهای موجود در آن ، در برگه ی

نیز نگاهی  Outline بهتر است به محتویات برگه نمایش داده شده اند. حالا PowerPoint سمت چپ محیط

 بیندازیم.

 کلیک کنید. Outline روی برگه
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می توانید متون موجود در اسلایدها را مشاهده کنید، این برگه برای کار بر روی عناوین و  Outline در برگه

 مطالب موجود در اسلایدها بسایر مناسب می باشد.

 د.کلیک کنی Slides روی برگه ی
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همانطور که قبلا گفته شده، با استفاده از چهار کلید موجود در سمت راست نوار وضیعت می توانید نمای نمایش 

فعال می باشد. در  Normal در حالت پیش فرض نمای عادی یا PowerPoint اسلایدها را تغییر دهید. در

انتخاب شده است. نمایش  Outline ای Slides در هر زمان تنها یک اسلاید که در برگه ی Normalنمای

 داده شده و شما می توانید آن را ویرایش کنید.

 کلیک کنید. Slide Sorter روی کلید مربوط به نمای
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زمان و در کنار هم مشاهده کنید. این هم را نمایش از اسلاید چندین ،Slide Storter شما می توانید در نمای

حذف یا مرتب سازی اسلاید ها و نیز افزودن جلوه های تصویری به اسلایدها  نما بیشتر برای عملیاتی از قبیل

 نگاهی می انداریم. Reading View مفید می باشد. اکنون به نمای

 ، که با فلش مشخص شده است ، کلیک کنید. Reading View روی کلید
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مایش در می آیند. کلید های موجود ، اسلاید ها به همراه جلوه های تصویرشان به ن Reading View در نمای

 در پایین این نما به شما این امکان را می دهند که بتوانید اسلایدهای را مرور کنید.

 ،که با فلش مشخص شده است، کلیک کنید. Slide Show روی کلید
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 می رد نمایش به تصویری های جلوه و اسلایدها ،Reading View هم مانند نمای Slide Show در نمای

. در واقع در این نما، اسلاید شوند می داده نمایش صفحه تمام بصورت ها اسلاید نما این در که تفاوت این با آیند،

را فشار دهید و یا از گزینه  Esc ها بصورت تمام صفحه نمایش داده می شوند. برای خروج از این نما باید کلید

 ر می شود، استفاده نمایید.منویی که با کلیک بر روی آیکون پایین صفحه ظاه

 را از صفحه کلید فشار دهید. Esc کلید

 باز گردیم Normal برای ادامه بهتر به نمای

 کلیک کنید. Normal روی کلید نمای
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می توان اسلاید ها را به صورت سیاه و سفید نیز نمایش داد. برای این منظور از  PowerPoint در

 استفاده کنید. View برگه واقع در Black and White گزینه

 کلیک کنید. View روی برگه ی
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 توجه کنید که این اسلاید چگونه به حالت سیاه و سفید درآمده است.

از این نما می توان به عنوان پیش نمایش چاپ سیاه وسفیداسلاید استفاده کرد. برای رنگی کرئن مجدد اسلاید از 

 اضافه شده است استفاده کنید. Ribbon که به Back to Color Viewکلید

 کلیک کنید. Back to Color View روی کلید
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در هنگام کار با اسلایدها . برای انتقال به اسلاید های قبلی یا بعدی می توانید از نوار لغزان عمودی که در سمت 

ر توضیح ظاهر میشود راست صفحه وجود دارد استفاده کنید، در این حالت در هنگام حرکت بین اسلاید ها،یک کاد

که شماره اسلاید در حال نمایش را نشان میدهد. زمانی که عرض یک اسلاید از عرض منطقه نمایش اسلاید 

بیشتر باشد.یک نوار لغران افقی نیز در پایین ظاهر میشود. شما همچنین میتوانید با کلیک بر روی پیش نمایش 

 مشاهده کنید.اسلایدها در چپ صفحه، اسلاید مورد نظر خود را 
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همچنین، با کلیک بر روی کلید های اسلاید قبلی و اسلاید بعدی که در پایین نوار لغزان عمودی قرار دارند 

میتوانید بین اسلایدها حرکت کنید. البته با استفاده از این کلید ها ، هر بار فقط به اندازه یک اسلایدبه جلو یا عقب 

در حال نمایش میباشد و ما می خواهیم به اندازه  1 ال حاضر اسلاید شمارهجابجا خواهید شد. برای مثال، در ح

 یک اسلاید به جلو حرکت کنیم.

 .کنید کلیک است، شده مشخص فلش توسط که ،Next Slide بر روی کلید
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قت کنید که اسلاید فعلی در دظاهر شده است.  2اکنون همانطور که مشاهده می کنید اسلاید شماره 

 با یک حاشیه نارنجی رنگ مشخص شده است. Slides برگه

از صفحه کلید می  Page Up و Page Down راه دیگر برای جابجایی بین اسلاید ها، استفاده از کلید های
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 باشد. بهتر است این روش را هم امتحان کنیم.

 را فشار دهید تا به اسلاید قبل بازگردید. Page Up کلید

 

 

 

آشنا شدید.  PowerPoint اول نمایش داده شده است. حال که با محیط نرم افزار به این ترتیب، مجدداسلاید

اجازه دهید این نمایش را ذخیره کرده و بعد آن را ببندیم. برای ذخیره سازی یک نمایش،می توانید از 

کلیک  Quick Access از نوار ابزار Save استفاده کنید و یا بر روی کلید File واقع در صفحه Save دستور

 نمایید.

 کلیک کنید. Save روی کلید
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را انتخاب  Close گزینه ،File ، کافیست از صفحه PowerPoint برای بستن یک نمایش، بدون خروج از

 کنید.

 کلیک کنید. File روی کلید
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 را انتخاب کنید. Close در صفحه باز شده گزینه
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 تهیه نیز پشتیبان نسخه یک خود فایل از ،File در صفحه واقع Save As شما می توانید با استفاده از گزینه 

 .نمایید ذخیره دیگر محل یک در و دیگر نام یک با راحتی وآن کرده

 کلیک کنید. File روی کلید

 را انتخاب کنید. Save As گزینه

 

 

اندهی فایل باز شده است.این پنجره دارای گزینه های زیادی برای ذخیره سازی و سام Save As اکنون پنجره

برای مقاصد  Save As است اما از پنجره Open ها و پوشه ها می باشد. نمای ظاهری این پنجره مانند پنجره

دیگری استفاده میشود.برای مثال ، شما میتوانیدیک کپی پشتیبان از فایل نمایش خود تهیه کنیدو آن را بعنوان 

 د. پایه ای برای نمایشهای دیگر مورد استفاده قرار دهی


